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Dentrix Mastery Tracks™ online training
will help you become the Dentrix
KNOW-IT-ALL your office needs!
Mastery Tracks training will help your team members better prepare
to use Dentrix on the job—in just a matter of days. Team members
can learn the essential components of Dentrix, allowing them to be
more effective right away. Even long-time employees can benefit
from a great refresher. And, for team members ready to expand and
deepen their skills, Dentrix Mastery level training is also available.
Mastery Tracks online training is included with your Dentrix
Customer Service Plan. So, what are you waiting for? Become the
team KNOW-IT-ALL today!

Take advantage of all that
Dentrix Mastery Tracks has to offer.
Log in at Dentrix.com/resource-center
and select “Get Your Training.”

Get Dentrix News,
Tips and Information
Sent Right to Your Inbox.
The Dentrix eNewsletter will help you stay up to date on the latest Dentrix
product information, education opportunities, industry news, tips and
tricks, promotional offers and more! Once a month you’ll receive an
eNewsletter featuring the following content:

Product
Information

Training
& Support

The Dental
Business

Partner
Products

Tips
& Tricks

Sign Up Today at www.Dentrix.com/newsletter
and don’t miss out on the most up-to-date Dentrix information!
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GIVING BACK

Dentrix Mastery Tracks

SPOTLIGHT
Dentrix Mastery Tracks™ helps dental professionals
improve, measure, and demonstrate their Dentrix skills.
Read on to find out about Anais Dakin, an orthodontic
assistant who has completed seven Mastery
Tracks tests and earned three specialist certificates.

ANAIS DAKIN | ORTHODONTIC ASSISTANT

Where do you work?

What got you interested in Dentrix Mastery Tracks?

Carrie Webb Orthodontics, Whittinsville, MA

When I found out about Dentrix Mastery Tracks, I felt like it
would be a great way to both test my knowledge and showcase

What is your title?

all the time I spent learning Dentrix in workshops, on the job,

Orthodontic Assistant

and through self-study at home.

What are some of the duties you’re responsible for
within your practice?

How has participating in Mastery Tracks helped you use
Dentrix?

Currently, I am learning a new skill set as an orthodontic

Participating in Mastery Tracks has helped to bring together

assistant. In the past, I was a Consulting Practice Coordinator

everything I have learned over the years in Dentrix.

for an endodontic office and a Clinical/Business Manager
my knowledge of Dentrix to help create a more efficient

How has becoming a Dentrix specialist improved your
career?

administrative and clinical workflow. My main duties included

Becoming a Dentrix specialist has helped me to gain a wider

practice coordination, training, and staff development.

range of opportunities to apply my skill set in the dental

for a general dentistry practice. In those positions, I used

industry. Recently I helped to open a new endodontic practice,

How long have you been with this practice?

and I plan to use my Dentrix knowledge to continue building

I joined Carrie Webb Orthodontics in April of 2017.

my career.

How long have you worked with Dentrix?

What is your favorite Dentrix tip or trick?

I have worked with Dentrix for 9 years.

There are so many great Dentrix tips and tricks. I love using the
Office Journal to keep track of patient phone calls and create

Which certificates have you earned?

to-do lists. When used to its potential, Dentrix can really help a

I have earned the Dentrix Clinical Specialist, Dentrix Financial

practice to shine!

Specialist, and Dentrix Front Office Specialist certificates.

Take a course. Take a test. Earn a certificate.
Visit Dentrix.com/Mastery and start using Dentrix Mastery Tracks to
help your team improve, measure, and demonstrate their Dentrix skills.
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Dentrix News

Announcing New Insurance Payor Connections

eClaims
Dentrix has eClaims connections with several new payors.
For patients using the following insurance carriers, you
can reduce paper claims by submitting electronic claims
through Dentrix instead.
Payor ID

Payor Name

38238		Allegiant Care (formerly known as
Northern New England Benefit)

After you have sent claims and attachments to payors
electronically, complete the electronic claim round trip by
accepting electronic explanation of benefit statements
(eEOBs) that the insurance carrier sends back to you. The
following payors now send eEOBs.
Payor ID

Payor Name

18014		Aetna Medicare EPO/PPO Dental

BEAM1		BEAM Insurance Administrators

CBIA1		Blue Cross Blue Shield of Iowa-FEP

35245		Continental Benefits

CX049		Coventry Dental

38225		CoreSource Detroit, MI (formerly
known as NGS)

CX049		Denex Dental

DTCA7		Dental Transformation Initiative (DTI)

DDCA3		DentalCare USA Encounters

95411		FL MCO PHC/PHP

EMBDQ		DQ/Emblem (Emblem Health

21614		PACE Greater New Orleans (NORLIN)
CB695		Resolve/Solarte Health Inc.
For more information about Dentrix eClaims, visit
www.dentrix.com/products/eservices/eclaims.

DDCA2		DentalCare USA Claims

Medicaid/Denta Quest)
58379		Echo HealthCare Inc.
CX036		Group Dental Services (GDS)
CX073		Kaiser Permanete Dental Choice
52180		UMWA Health & Retirement Funds
CBIA1		Wellmark Blue Dental–FEP

eClaims
The following payors now accept electronic claim
attachments. With electronic attachments, you can add
digital X-rays, EOBs, photos, and perio charts to the
electronic claims you send.
Payor ID

Payor Name

EMBDQ		DQ/Emblem (Emblem Health Medicaid)

4 | www.Dentrix.com/Magazine

For more information about eEOBs or to register, visit
www.dentrix.com/products/eservices/eclaims/eeob.
View the entire list of electronic payor connections using
the Payer Search Tool at www.dentrix.com/products/
eservices/eclaims/payor-search. You can search for specific
payors or download the complete payor list.
Call 800-734-5561 for help setting up any of these services.

is here

Take a look at what you can do with Dentrix G6 with testimonials and new feature demo
videos. You’ll see why your team will want to start using Dentrix G6 as soon as possible.

Visit

Dentrix.com/G6 to request your copy today.

Product
Management

New Features in 2017 With More
Changes to Come!

See what Dentrix has done in 2017 and
prepare now for upcoming changes.

O

ver the last year, I have provided a sneak peek into
some of the upcoming Dentrix releases as well as
changes that you can prepare for now in
anticipation of those updates. I wanted to take this
opportunity to track the progress on our 2017 updates and
reiterate some changes that will be coming so you are ready
when they arrive.
Dentrix Enhancements and Product Releases
In the Winter 2016 issue of Dentrix Magazine, we discussed
plans for 2017. With an active customer service plan, you
are eligible for upgrades and feature enhancements as they
are released. As a commitment to you, we have moved to
a quarterly release schedule for Dentrix. As such, feature
enhancements and improvements are coming to you more
frequently. So far this year the following updates and
features have been released:
Dentrix G6.3 (released March 2017):
• Practice Advisor improvements. Treatment Plan Case
Acceptance Totals and Amount of Treatment Accepted
and Diagnosed have been modified to more accurately
depict the state of each of these key performance indi-
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cators. Also, you can now select only Dentists or only
Hygienists to limit your review to that specific group.
•

Appointment Book Production. Added an option to
calculate production amounts based off of an adjusted
total so you can see how you’re tracking against insurance write-offs, refunds, and so forth.

•

Medical Cross Coding. You can now share
diagnostic codes between dental and medical
without double entry.

Dentrix G6.4 (released June 2017):
• Credit Card Payment Type on Insurance Claims.
Credit cards can now be selected as a payment type
when entering an insurance payment. The batch
insurance feature also has this added ability. The Day
Sheet, deposit slips, and Practice Analysis Payment
Summary will show that a credit card was used for
insurance payments.
•

New Payment Agreement Manager. A Payment Agreement Manager was created to show all the Payment
Agreements. It allows for filtering, payment entry without having to go through the Ledger, and many sort
options. Within Payment Agreements, the Payment
Agreement Notes have been upgraded so that they are
easier to navigate and edit.

I wanted to take this
opportunity to track the
progress on our 2017 updates
and reiterate some changes
that will be coming so you are
ready when they arrive.
Dentrix G6.5 (releasing soon):
•

Month End and Task Scheduler. The
Month End Wizard is now the Reports
and Tasks Scheduler. You are no longer
required to close Dentrix on all computers
to do your month-end tasks! The Task
Scheduler allows you to set up reports
or tasks to run on a schedule on a daily,
weekly, monthly, or yearly interval. It has
all the tasks and reports from the Month
End Wizard, plus many more.

•

New Appointment Lists. Appointment,
ASAP, Pinboard, and Unscheduled lists
have been combined into one customizable and searchable list to simplify finding
and scheduling appointments. You can
now move appointments to the Pinboard,
change appointment status, or break
appointments in bulk.

•

Questionnaire Improvements. Lists have been updated to
quickly see what needs to be filled out or updated. You
can now add existing insurance subscribers when updating insurance subscribers from a questionnaire form.

Prepare Now For Upcoming Changes
Operating System Requirements. In the Spring 2017 issue of
Dentrix Magazine, I discussed changes to Microsoft operating
system requirements with Dentrix, including the use of our
eServices. I stated that we will no longer be able to process
transactions that come from any unsupported Microsoft
operating systems. The reason is that these operating systems
cannot send data using the latest transport layer security
(TLS) version of 1.2 or higher but instead submit using older,
outdated methods.
Many of our eServices have officially been moved over to use
the latest transport layer security (TLS) version of 1.2. What is
important to note is that as of Dentrix G6.5, only the following
operating systems will be supported with Dentrix:
Servers:
• Windows Server 2016
•

Windows Server 2012 Standard/Datacenter (R1/R2)

•

Windows Server 2008 Standard/Enterprise/Datacenter
(R2 SP1)

Dentrix Passwords Now Required. In the Winter 2014 issue of
Dentrix Magazine, I discussed multi-layered security practices.
As part of that article, I discussed one important first line of
defense that should be coupled with all other industry standard
and best-practice security requirements: passwords. As such,
in a release of Dentrix coming in the first half of 2018, use
of passwords will be required in Dentrix. Additionally, those
passwords will employ today’s standards for complexity,
expiration, and timeout.
In anticipation of that release, please start today by ensuring
your passwords are enabled in Dentrix and that all users
have appropriate access to the various areas of Dentrix. You
can also start using the appropriate password complexity
requirements for that upcoming release now. Those
requirements will be a minimum of eight characters with at
least one uppercase and one lowercase alpha character, at
least one numeric character, and at least one special character
(such as #@$*). Again, this should not be the only line of
defense. We highly recommend that you work with both
computer and security policy experts to implement safeguards
based on industry standards and best practices.
I am very excited about the future as we continue to partner
together to continuously improve upon the great foundation
of Dentrix. If you have any questions or would like to suggest
areas of improvement in the product, please don’t hesitate to
reach out to me at brad.royer@henryschein.com.

Workstations:
• Windows 10
•

Windows 8.1 Professional/Enterprise

•

Windows 7 Professional/Enterprise/Ultimate (SP1)

BRAD ROYER
Dentrix Product Manager
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Digital
Dentistry
Your Way
Henry Schein ConnectDental® , Henry Schein’s
platform for digital dentistry, integrates a wide choice
of innovative, scalable digital technologies into every
step of the clinical workflow. We are committed to
helping you:

• Enhance the patient experience
• Deliver predictable, quality dentistry
• Improve efficiency and productivity
Making the right solutions work for you.
Practice Management Software
Clinical Treatment Software
Laboratory Software
Patient Marketing
Patient Education Software
2D/3D Imaging
Intraoral Cameras

Scanners
Milling Units
3D Printers
CAD/CAM Materials
Dental Implants
Caries Detection Devices
Computer Hardware

For more information about our Henry Schein ConnectDental Trusted Digital
Solutions, please contact your Henry Schein Dental Sales Consultant or call
800-890-8153 for full product information.

www.henryscheindental.com

Tips

&Tricks

Front Office
Making Your Lists More Manageable

These tips simplify workflow and
increase efficiency. Find the tips that
correspond to your role in the practice.
Start making your job easier and your
practice more profitable today.

When you use tools like the Collections
Manager or Treatment Manager to
generate lists of patients, try using the
patient range option to limit the size of
your list to make it more manageable.
For example, run the list for patients
with A - J names, and then after working
through that list, run the list again, for
patients with K - S names, and so on.

Front Office
Finding Specific Groups of Patients in the Treatment
Manager
You can use the Treatment Manager to find patients to fill light
days in your schedule. For example, you can generate a list of
active patients who have had procedures treatment-planned
within the last 12 months and still have at least $250
of insurance benefits remaining for the year so you can get
them scheduled.
To create this Treatment Manager view:
1. From the Appointment Book, click the Treatment
Manager button.
2. In the Patient Status field, select Patient to only include
patient with that status on the list.
3. In the Treatment Plan group box, enter a range of
treatment plan dates you want to include on the list.
4. In the Insurance group box, enter $250 for the minimum
amount of benefits remaining for the year.
5. Click OK to load the filters and display the list of
matching patients.

Financial
Which Payment Goes with This Claim?
The Dentrix Ledger contains individual
line items for every completed procedure,
insurance claim, payment, adjustment,
finance charge and late charge made on the
account. It can quickly get confusing to look
at, particularly when viewing the Ledger for
all family members, or looking at the Ledger
plus history for the account.
To help make it easier to locate transactions
that are related to each other (payments
attached to procedures or claims, for
example), Dentrix has a Show Transaction
Links option, which will highlight line items in
the Ledger that correspond with one another.
For example, if you want to see which
procedures are included on a particular
claim, you can select the claim and use Show
Transaction Links to view the procedures and
payments attached to that claim.
To show linked transactions:
1. In the Ledger, select a patient.
2. Select a claim and click View > Show
Transaction Links.
Dentrix highlights every transaction entry
that is linked to the one you selected. This
can help to make sense of a potentially
confusing Ledger that is full of entries.
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Practice Analysis
Identifying Which of Today’s Patients have Unscheduled Treatment
Talking to patients about treatment-planned procedures is most easily done face to face. If you know ahead of time which of
today’s patients you need to talk to about their planned treatment that needs to be scheduled, you can prepare to have those
conversations with patients while they’re in your office.
You can customize the Daily Huddle Report to show which patients coming in today have unscheduled treatment. You can then
use this information in your morning meetings and plan to discuss treatment with patients as they are seen for their appointments.
To generate the Daily Huddle Report:
1. From the Office Manager, click
Analysis > Practice Advisor, and
then click Daily Huddle Report.
2. Select the report date, providers,
and other report options as desired.
3. In the Select Report Sections &
Related Options group box, check
Scheduled Patients Summary and
then click the Scheduled Patients
Setup button.
4. In the Select Report Sections
& Order list, check the Patients
who have Treatment Plans option
to identify patients who have
unscheduled treatment on the list.
Select other report sections you
want to include as desired.
5. Click OK to save your settings, and
then click the Preview button to
view the report.

Practice Analysis
Narrowing Your Focus when Generating the Aging Report
The Aging Report shows all the accounts with a balance in a specific
aging bracket. You can customize this report to show a range of
patients, providers, billing types, minimum balance, and minimum
days past due. This lets you create a report that only shows you
the information you want to see without having to weed through
information outside your focus.
Let’s say you wanted to concentrate on accounts that haven’t made
a payment in the last 30 days. By default the Aging Report includes
all accounts, regardless of their last payment date. But, you can use
the Last Pmt Before date to exclude accounts that have made a
recent payment. For example, if the date entered in this field is for
the prior month, Dentrix excludes any accounts that have made a
guarantor payment within the prior month from the Aging Report.
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Financial
Updating Office Fees
With the end of the year fast approaching, it may be time
to think about updating the fees you are charging for
procedures, in preparation for a new year.
When you use the Automatic Fee Schedule Changes
utility, you can change an entire fee schedule or range
of procedures at once rather than changing one fee
at a time. For example, if you want to increase your
continuing care production, you could increase your
office fees for diagnostic and preventive procedures by
3% across the board.
To update fees for a range of procedures:
1. From the Office Manager, select Maintenance >
Practice Setup > Fee Schedule Setup.
2. Select the fee schedule you want to update, and
click Auto Changes.

Financial
Why Don’t My Insurance Estimates
Match the Estimates Dentrix Calculates?
One of the questions that often comes up in
customer service phone calls is, “Why don’t
the estimates I calculate by hand match the
estimates Dentrix calculates?”
In order to calculate the correct insurance
portions, Dentrix uses formulas that reflect
real insurance adjudication practices. Most
importantly, these formulas use specific orders
of operation to arrive at the insurance portion
calculation. As a result, if you try to manually
calculate these portions without using the
same order of operations, you may arrive at a
different amount.
For example, let’s say that your patient Bob
will be charged $152 for a procedure that
insurance usually covers at 80%. First, Dentrix
will determine which formula to use.
•

3. In the Select Procedure group box, set the range of
procedures you want to include.
4. In the Change Fee Schedule group box, do the
following:
• In the Change Amount field, enter the amount to
change the fee schedule by.
•

In the Change Type drop-down list, select
whether you want to increase/decrease by either
a percentage or dollar amount. Your choice
here reflects the Change Amount by applying
the number entered in that field as either a
percentage or dollar amount.

•

In the Round To drop-down list, select the
amount to round the fee schedule amount to.

•

In the Minimum Amount to Increase field, type
the minimum amount you want to change the
fee schedule. For example, if you enter $.50
in this field, all fees will be updated by at least
$.50. Note: This option is only available when
increasing/decreasing by a percentage.

5. Click OK. Review the summary of the fee schedule
changes and then click Save.

If Bob does not have a deductible to be
applied, the formula used is:
(Insurance Portion) = (Charge Amount)
X (Coverage %) or (Payment Table
Amount). So the Insurance portion would
be ($152 X .8) or $121.60.
• If Bob has a $50 deductible to be
applied, the formula used is:
(Insurance Portion) = (Charge Amount
- Deductible) X (Coverage %). So the
insurance portion would be (($152 - $50)
X .8) or $81.60.
• If Bob has a $50 deductible to be
applied and there’s a $96 payment table
entry, the formula used is:
Insurance Portion = [(Pay. Table
Amount / Coverage %) - (Deductible)] X
(Coverage %). So the insurance portion
would be ([($96 / .8) - $50] X .8) or $56.

As you can see, even though the charge
amounts are the same for each example, the
insurance portion is different depending
on which formula Dentrix uses to perform
its calculations. If you don’t use the same
formulas Dentrix uses or you don’t do the
math in the same order as Dentrix, your
results will be different.

For additional information, see the Fee Schedules topic
in the Dentrix Help.
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Clinical
Adding Procedures to the Procedure Codes List
Your clinical staff may find that the procedure codes
they use most often are not listed in the Procedure
Codes list in the Patient Chart, and that they have to
click the More Codes button in order to access them.
You solve this problem by adding procedure codes to
the Procedure Codes list.
For example, procedure code D4355 is not listed in
the Procedure Codes list by default. If the hygienists in
your office treatment plan that code often, you can add
it to the Procedure Codes list to help them enter this
procedure quicker.
To add a procedure to the Procedure Codes list:
1. From the Office Manager, select Maintenance >
Practice Setup > Procedure Code Setup.
2. In the ADA-CDT Codes tab, select the procedure
code you want to add to the Procedure Codes list
and click Edit.
3. In the Treatment Flags group box, check the box
for Show in Chart. When checked, this procedure
code is listed under the corresponding category
in the Procedure Codes list in the Patient Chart.
4. Click Save to save your changes and then
click Close.

Financial
Setting Up a Payment Agreement in Dentrix G6.4
At times, a patient may need to pay off a procedure or balance over time. You can accommodate these patients by setting up a
payment agreement with them in which they agree to pay off their balance through regular payments instead of in one lump sum.
To set up a payment agreement in
Dentrix G6.4:
1. From the Ledger, select a
patient and click the Billing/
Payment Agreement button.
2. From the Billing Type dropdown list, select the billing type
to be assigned to the account.
3. Enter the agreement date and
select the payment interval
from the drop-down list.
4. Enter the annual finance charge
percentage, total amount of the
agreement, first payment due
date, and payment amount in
the corresponding fields.
5. Click the Agreement Templates
button and select the terms to
apply to the agreement from
the list of options, and click OK.
6. Click OK to save the agreement.

Follow Dentrix on Facebook to
get tips like these every Tuesday!
12 | www.Dentrix.com/Magazine
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Why take so much of your valuable time to
manually create, submit and track claims when
you can do it all within Dentrix?
With Dentrix eClaims, you can conveniently accelerate the
insurance claims process by quickly creating, validating and
sending electronic claims to one of the largest payor lists in
the industry. It pays to use the only electronic claim service
that is actually part of your Dentrix software. You deserve
more. Step up today and stake your claim to accelerated,
convenient claims processing.

Bundle eClaims and Save You can claim deep discounts on eClaims when
you buy it as part of a Dentrix Service Bundle — powerful eServices that connect
directly to Dentrix, helping you boost your productivity and streamline your workflow.

Call 1-800-734-5561, option 2 and use promo code #1-320934276
to get eClaims and determine the best bundle for your practice.

Service Bundles

You deserve more.
Dentrix.com/ServiceBundles

FOR HIGHER EFFICIENCY,
PRODUCTION AND PROFIT
CATHY JAMESON
Founder and CEO of
Jameson Management, Inc.

How to reduce no-shows, cancellations,
and stress in your dental practice

P

oor scheduling can be a major source of
stress in your dental practice. If your
Appointment Book is full but office tension
is high, your scheduling process may be broken.
Ask yourself:

1

2

Are cancelled appointments and no-shows an
epidemic in your practice?
•

Does your office consistently run behind
schedule?

•

Are you rushing one appointment so you
can get on to the next?

•

Does it take weeks before you can fit
a new patient into your schedule?

•

Does your schedule allow you to perform
the kind of dentistry you want to do?

•

Are schedule holes causing excessive
stress on you and your team?

•

Is your schedule so overbooked that
you don’t even have time to eat?

•

Is your schedule burning you out?

If you answered “yes” to at least three of these
questions, your scheduling process needs repair.
Done properly, scheduling can reduce no-shows,
cancellations, and stress in your dental practice.
When you have days that are better organized,
your patients will receive more quality attention
from you. Your improved concentration and
lowered stress will benefit you and your patients.
Plus, you’ll get to practice the kind of dentistry
you want.

Give patients a reason to come back. At the end
of every appointment, the clinical team member who
is with the patient should stress the significance of
the next appointment. Discuss the benefits of the next
appointment and the possible risks of not showing up.
Learn the verbal skills of scheduling. The
appointment coordinator should indicate the amount
of time being blocked for the patient in the doctor’s
schedule. Help the patient accept responsibility by
saying something like, “The doctor has reserved this
time for you and we’re relying on you to be here.”

3

Confirm appointments. Confirm in a positive manner

4

Change your after-hours voicemail greeting.

5

Reschedule immediately. If a patient calls about

6

Bring it up in morning meetings. During your
daily team huddle, discuss how to fill any voids in the
hygienist’s or doctor’s schedule. Enlist team members
to audit charts and look for patients who could
possibly fill the open time slots, such as those with
past-due treatments, unappointed restorative work,
or unappointed family members.

and always stress the importance of the appointment
and the patient’s responsibility for the appointment.

Some patients will call at night and leave a recorded
cancellation message. Discourage this by changing
your greeting to reflect the preference that they call
during business hours.

changing an appointment, reschedule them while
they are on the phone.

Preventing Schedule Problems
Preventing broken appointments, no-shows,
and other schedule problems isn’t just the
appointment coordinator’s job—it’s everyone’s
job. Here are six ways your team can help:
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dollar value. Tertiary procedures such as seating of
crowns and bridges, suture removals, have no dollar
value attached.

Building a Balanced Schedule
Building a balanced schedule—with the right mix of
primary, secondary, and tertiary procedures—allows
your practice to avoid highs and lows in production
(Figure 1). Primary procedures, such as crown and
bridge, endodontics, dentures, partials, and most
cosmetic procedures, have a higher dollar value
attached to them. Secondary procedures, such as
simple composites and extractions, have a lower

The secret to getting the right mix of procedures
into your schedule is pre-blocking—reserving
specific time slots each day for primary procedures.
Pre-block your days for approximately half of your
production goal. Then add secondary and tertiary
procedures around your primaries as needed.
The key to productivity is not how many patients you
see in a day, but how much dentistry you do in a day.
Schedule a variety of procedures each day to meet
a specific daily production goal, rather than aiming

Figure 1 Example of a balanced schedule with a mix of procedures.
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for a certain number of patients per day. For example,
let’s say your monthly production goal is $70,000 and you
work 16 days per month. Divide $70,000 by 16 to find your
daily production goal of $4,375 per day. Break this down
to $3,000 for the doctor and clinical team and $1,375 for
the hygiene department. This smooths out the highs and
lows, increases your productivity, and reduces financial
and physical stress for you and your team. As a result,
your patients will appreciate you more.
Dentrix includes a Perfect Day Scheduling tool you
can use for pre-blocking appointments to meet your
production goals. To activate Perfect Day Scheduling,
from the Options menu in the Appointment Book, click
Perfect Day Scheduling. Dentrix displays each provider’s
time blocks. To move a time block within its respective
operatory, drag the time block to the time you want.
To increase or decrease the time block’s size, drag the
bottom border of the time block down to increase or up
to decrease the block’s size.
Sell the Value of Every Appointment
Dental appointments deal with people’s money and
time, two of the most important things in their lives.
People break appointments if they don’t understand their
importance—or value—compared to everything else going
on in their busy lives.
Part of fixing scheduling problems includes improving
treatment recommendations. If your patient is only
interested in how much their insurance will cover a given
treatment, you’ve failed to sell the value of your services.
The following strategies help you communicate value
when presenting recommended treatment:
•

Empower your hygienists. Hygiene appointments are
the most frequently broken type of appointments.
Patients may not feel the need to come in if they’re
not experiencing any problems. Because 40 to 60
percent of the dentist’s production comes directly
from hygiene, it’s critical to empower hygienists as
patient educators. Give them the time, equipment, and
technology to help patients see the value and benefits
of treatment.

•

Use visual aids. Videos, photos,
and X-rays help show patients
“this is what’s going on in your
mouth.” Show before and after
pictures to illustrate treatment
benefits (or risks of skipping
treatment).

•

Discuss total wellness. Explain how
your treatment will help patients with
their health, appearance, breath, snoring, or other
wellness issues.

•

Listen. Answer patients’ questions and hear out their
concerns. Slow down and pay a little bit more attention
to people and what brought them to you in the first
place. This builds a relationship of trust that will solidify
their commitment to attending appointments.

•

Find financial solutions. Work with your patients
to find payment options so they can overcome any
financial barriers to treatment. If patients aren’t clear
and comfortable with the financial arrangements,
they’ll cancel or no-show.

Coping With a Broken Schedule
Even if you follow the best scheduling practices, someday
your schedule will fall apart. No-shows are the worst. Call
any patient that is five minutes late. If they answer, express
concern: “We have this time reserved for you, are you
OK?” See if they can come in for a partial appointment
and at least get them rescheduled. Put the patient data in
the tickler file if you are unable to reach them. Remember,
today’s lost production is lost forever. It’s more important

to focus on filling today’s schedule than four weeks
out. To fill last-minute openings, look at your
Appointment Book.
•

Is there someone from restorative you can move
to hygiene, or vice versa?

•

Is there someone in the afternoon you can move
to morning?

•

Is there someone scheduled tomorrow or later
this week you can move to today?

Dentrix can help you generate current lists of patients
you can call to fill unexpected schedule voids.
•

Use the ASAP List for patients who want to get
in sooner than originally scheduled.

•

Use the Continuing Care List for unscheduled
patients who are overdue for hygiene.

•

Use the Treatment Manager Report for finding
patients who need a certain procedure so you
can fill a specific time slot.

•

Generate a custom list for patients who have
treatment plans posted to the Ledger and unused insurance benefits available.

•

Use the Unscheduled List for patients who have
either broken an appointment or asked to be on
will-call.

Use these Dentrix tools and scheduling tips prevent
scheduling problems and build a more productive
and profitable schedule.
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Note: This article is a summary of Cathy Jameson’s
eBook, “Scheduling for Higher Efficiency, Production
and Profit.” Visit www.Dentrix.com/Efficient or scan
the QR code to download the full eBook.

Cathy Jameson is the founder of Jameson
Management, an international dental management,
marketing and hygiene coaching firm. The Jameson
Method of Management, developed by Cathy, offers
proven management and marketing systems for
helping organizations improve their workflow and
efficiency in a positive, forward-thinking culture.
Cathy earned a bachelor’s degree in education
from the University of Nebraska at Omaha and then
a master’s degree in psychology from Goddard
College. She received her doctorate from Walden
University. She considers herself a lifelong learner
and encourages those around her to be in a constant
state of study, growth and action. She is the author
of several books, including her latest title “Creating a
Healthy Work Environment.” For more information on
Jameson Management’s services, visit their website
at jamesonmanagement.com.

Consider It Done.
As an office manager, you’re
expected to do it all—scheduling,
billing, insurance, appointment
reminders and more—while
keeping production up and costs
down. We’d like to give you a
hand. Our Dentrix Service

Call your account
executive today at
844.852.3155 to
get your Dentrix
Service Bundle now.
Learn more at:
Dentrix.com/ServiceBundles

Bundles are packed with
eServices—powerful tools
connected to Dentrix that help
boost your front office
productivity and streamline
your workflow. Now you can
automate the tasks you
shouldn’t be doing manually.
Done and done. Bundle your
eServices and save!

Service Bundles
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WORKSHOP WISDOM
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This excerpt from the Accounts Receivable Management
workshop will teach you how to split payments by family
members in Dentrix. You’ll save time by not having to
enter multiple payments and ensure that your payments
are correctly posted in Dentrix.

FAST FAMILY PAYMENTS:
LET DENTRIX DO THE MATH
RODNEY MERRILL
Curriculum Development Specialist

I

n order to keep accurate records, it’s important to
enter payments for the correct provider on the
correct patient account. Dentrix G6 includes a new
feature that helps you do that even when you are
splitting a single payment among several family
members. Dentrix does the calculations for you and
posts the payment to the patients and providers you
choose, so your entries are accurate and precise.

THE PROBLEM
When a patient makes a single payment that needs to be applied to multiple family
members, you have to manually calculate how to split that payment. You have to choose
a family member, accurately calculate the portion of the payment to be applied to that
patient, enter all the payment information, ensure that the payment is allocated to the
correct provider(s), and then post the payment. Then, you have to repeat the entire
process for every family member for whom the payment applies. And since it’s a manual
process, it’s time-consuming and easy to have miscalculations and errors.

THE SOLUTION
Use the new Split Payment by Family Members feature
to split a single payment among several family members,
all from one dialog box. Dentrix automatically calculates
the split and posts payments for selected family members
who have outstanding balances. You enter payment
information only once and let Dentrix take care of the rest.
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Open your Dentrix system and use the
following steps to split a single payment
among several family members.

S E L E C T A PAT I E N T

1

AND ENTER GENERAL
PAY M E N T I N F O R M AT I O N

Open the Ledger and select one of the patients to whom
the payment applies. Click Transaction > Enter Payment. In
the Enter Payment dialog box, enter the following general
payment information: payment date, payment amount,
check number, bank/branch number, and payment type. This
information will appear on each payment that is posted for
each family member.
The current date will appear in the Date field. Change the
date as necessary. For example, you may want to back-date
a payment to the day it was received and not the day it was
entered, which may be a day or two later than when you
received it.

Enter the total payment amount and select the payment
type, which indicates how the payment was made. If you have
many payment types, you can use the search field to quickly
find the payment type you want.
Enter a check/payment number and a bank/branch number
as needed. These options can help you track payments if
there are questions or disputes about particular payments
and make it easier to see which payments are related on the
Day Sheet.

Figure 1 Enter the basic payment information that applies to all family members.
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2

W

ENTER THE SPLIT
PAY M E N T D E TA I L S

In the Patient drop-down menu, select Split By Family Members. This option allows you to split a payment among any family
members, including the guarantor, who have outstanding balances. If patients have been archived but still have individual balances
in the Ledger, the Split By Family Members feature can still allocate money to these archived patients’ balances. When you select
Split By Family Members, the Provider option box is grayed out, and Dentrix automatically splits the payment among the providers
who have balances on each family member’s account.
Next, from the Split Method drop-down menu, choose a split payment method to determine how Dentrix will calculate the amount
that will be applied to each family member’s balance.
•

The Percentage Payments method
divides the payment among the
providers according to provider’s
percentage of the total amount
owed. The provider who is owed the
most receives the largest portion of
the payment.

•

The Guarantor Estimate method
applies the payment to providers
who have balances as guarantor
estimates, and it ignores provider
balances that Dentrix estimates
insurance will pay the remainder of.

•

The FIFO (First In First Out) method
applies the payment toward the oldest completed procedures first.

•

The Equal Payments method splits
payment amount equally among all
providers with debit balances.

Figure 2 Choose Split by Family Members and a split method.

You should decide on split payment methods that work best for your practice, and use them in a consistent manner. You can set the
default payment assignment options by clicking Payment Settings, selecting the defaults you want to use, and then clicking OK.
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Once you have entered all pertinent information for a
payment, click the Details button to display a list of how much
money each family member owes to which provider. The
list includes patients, providers, patient balances, guarantor
estimate amounts, and the amount to be paid (according to
your selected split method). You can sort the list by clicking
the Patient or Provider columns, and you can also hide (and
unhide) a patient’s information by clicking the arrows in the
Pay column.

STEP

3

CONFIRM SPLIT
PAY M E N T D E TA I L S

From this list, you can manually adjust the amounts being
paid. Double-click on any family member’s balance in the Pay
column and change it to the desired amount. The Remaining
Amount field will show you how much money you have yet to
allocate to each family member. You cannot post a payment
until the amount in that field is zero ($0.00).
You can also prioritize payments by choosing a provider
balance that you want to have the payment applied to first.
To give priority to a specific balance, select the line item of
the provider you want and click the Give Payment Priority to
selected items button. That balance will be paid off first, and
the remaining balance(s) will be paid according to the split
method that you selected.
The Provider Balances section of the dialog box lists the total
amount owed to each provider and what the provider’s new
balance will be once the payment is made. These amounts
will be updated as you adjust the payment amounts for each
patient and provider.
Figure 3 Adjust and confirm the split payment details.

STEP

4

F I N A L I Z E A N D P O S T T H E PAY M E N T

To finalize a payment there are two more
items you should consider: the Note field and
applying the payment to a patient’s payment
agreement.
In the Note field, enter a note to document
circumstances related to the payment. Click
the Insert Date Line button to insert a date
line into the note.

Figure 4 Enter a note and a date line.

If you want to apply this payment to a
payment agreement, check the Apply To Payment Agreement check-box. If the guarantor’s
account has a current payment agreement, this option will be checked by default. However,
if you do not want to apply the payment to the payment agreement, uncheck the box before
you finalize the payment.
To post the payments, click the OK button. Dentrix will post individual payments for each
provider on each patient account that was included in the split.

DENTRIX MAGAZINE | 23

WORKSHOP WISDOM

W

N

E

X

W

T

STEPS
U S E T H E F O L LOW I N G C H E C K L I S T TO
H E L P YO U I M P L E M E N T I D E A S F R O M
T H I S A R T I C L E I N YO U R P R AC T I C E

Dentrix workshops offer you a chance
to practice using Dentrix in a handson, trainer-led class. Workshops offer
examples of best practices
for using Dentrix in your office,
ideas for incorporating lesser-used
features into your workflow, and
advice about how to customize
Dentrix to suit your preferences.

Decide with your team what information you want to
include in the Check/Payment # or the Bank/Branch #
fields if the payment is not a check payment. Create a
policy for staff members to follow when posting payments.

Examine the payment types listed in your practice.
Determine if there are other types that you would like to
add or existing types you want to delete, and then make
those changes.

Train the appropriate office staff to split payments by
family members. Decide with your team whether you want
to make that the default setting.

Determine which split method, such as FICO, you want to
set as the default split method, and adjust the settings to
reflect it.

Create a policy about the notes you add to patient
payments. Decide what notes you want to enter when
you split a payment by family members, and train the
appropriate staff members to enter those notes each
time they use this feature.
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LEARN MORE

For more tips like the ones in this
article and to get in-depth training on
splitting payments by family members,
attend the Accounts Receivable
Management workshop. Visit
www.Dentrix.com/Workshops for
more information about this and
other training workshops,
including the full course list, course
descriptions, and schedule.
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Register TODAY for a hands-on
workshop in a city near you!
Insurance: Billing and Collections

Accounts Receivable Management

Do it right to get paid faster

per n
persoS

299

$

Gain an in-depth understanding of how to correctly bill
insurance in order to increase claim acceptance and
collect more quickly and easily. Includes G6 Ledger!

CR
6 CE

EDIT

1-day class for experienced Dentrix users
9 am – 5 pm | AGD subject code: 550

Take control of your patient A/R

per n
persoS

299

$

Learn to simplify the billing statement process, enhance the
effectiveness of collections efforts, and properly track and
manage important A/R routines. Includes G6 Ledger!

CR
6 CE

EDIT

Treatment Planning and Case Presentation

Clinical Charting

Create and present treatment options effectively

per n
persIToS

299

$

6 CE

Learn in-depth how to create, customize, present and
manage patient treatment plans for improved patient
education, case acceptance and documentation.

D

CRE

1-day class for experienced Dentrix users
9 am – 5 pm | AGD subject code: 550

Essentials Workshop
Master the basics

per n
persIToS
D

449

$

Become familiar with the essential Dentrix features that will
help you work more effectively in your practice, and
make your daily routines easier and more efficient.

E CR
12 C

E

2-day class for newer Dentrix users
9 am – 5 pm | AGD subject code: 550

1-day class for experienced Dentrix users
9 am – 5 pm | AGD subject code: 550

Move beyond just posting procedures

per n
persIToS

299

$

6 CE

Discover features that make charting easier and more efficient.
Learn to create thorough, accurate clinical records in the
Dentrix Patient Chart and Perio module.

D

CRE

1-day class for experienced Dentrix users
9 am – 5 pm | AGD subject code: 550

EARLY REGISTRATION SAVINGS!

OFF
40

$

PER SEAT

when you
register at least
3 weeks early!

View course descriptions and register online at

www.Dentrix.com/Workshops
or call 866.367.2711

Mastery Tracks professional skills assessment included with these workshops. All workshops offer 6 lecture-style CE credits per day. ©2017 Henry Schein Inc. A-DTXTRN-DTXMAG-Q317
Cancellations & Refunds: Full refunds are given for cancellations received 17 or more days before the workshop. A cancellation fee equal to the full tuition for the course will apply if you cancel with less than 17 days’ notice,
but you will receive a certificate good for another workshop within a year. No refunds or certificates for no-shows. Send cancellations and refund requests to: cancel@henryschein.com. We reserve the right to cancel a
class due to low registration. We recommend purchasing refundable travel tickets if you wish to obtain them before the workshop is confirmed, 17 days before the event. Henry Schein Practice Solutions does not reimburse
for purchased travel tickets and other incurred expenses. HSPS complies with the Americans with Disabilities Act. If someone in your party requires special accommodations, please notify us at least two weeks in advance.

The Dentrix
Office Manager

Manage Your Patient Referral
Information in Dentrix

Store referral slips and track gratuities in
your dental software.

I

was recently working with an oral surgery practice and a
periodontal office. At both of these offices I observed
that the referral coordinators had an accordion file filled
with referral slips of patients who had been referred to their
office but were not yet scheduled. Both offices were in the
process of going paperless, so we explored a system for
managing these patient referrals inside of Dentrix. In this
article, I’ll share my suggestions on how Dentrix can help
you manage your patient referrals.
When you go paperless, you will use the Document
Center to store a lot of documents that you used to store
on paper. If you’ve used the Dentrix Document Center,
you already know that you can use it to store and view
documents for individual patients. But did you know
that you can also use it to store and view documents for
selected providers, including referral providers? I’ll show
you how to do this.

In the Office Manager, from the Maintenance menu, point
to Reference, and then click Referral Maintenance. In the
Referral Maintenance dialog box, make sure you have all the
referral providers you want to use in both the Referred BY
and Referred TO lists. Click Close when finished.
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Figure 1 The Document Types Setup dialog box.
In the Dentrix Document Center, from the Setup menu, click
Document Types. In the Description field of the Document
Types Setup dialog box, type Referral, and then click Add
and Close (Figure 1). This adds a new Referral document
type that you can use for tracking referrals in the Document
Center. From the View menu, click By Provider/Staff, and
then double-click the provider you want to associate with

the first referral document. Using the Acquire menu, scan or
import the referral slip. In the Document Information dialog
box, set the Document Type to Referral. In the Description
field, I recommend typing the patient name. Click Modify
Attachments to display the Modify Document Attachments
dialog box. Click Referred BY, and double-click the name of
the referring provider. If you have already added the patient in
the Family File, click Patient, select the patient in the list, and
click OK (Figure 2). If you haven’t, you can add the patient
to Document Attachments later when you create the patient
record in the Family File. Click Close.
After using these steps to add all your patient referrals, you
can shred these referral slips and clean up your desk.
Tracking Gratuities
How are you tracking your gratuities to your referring doctors?
Do you have a manual spreadsheet that you use to track the
amazing gift baskets and coffee mugs you give away? Did you

LEARN MORE
To learn more about tracking referrals, see the “Referral
maintenance overview” topic in the Dentrix Help.
Dayna Johnson, founder and principal consultant of Rae
Dental Management, helps dental offices improve patient care,
increase collections, and reduce staff headaches by implementing efficient management systems. With 23 years of
experience in the business and technical side of dental offices,
Dayna’s passion for efficient systems is grounded in both
personal understanding and professional expertise. Dayna can
be reached at dayna@raedentalmanagement.com or visit her
website at www.raedentalmanagement.com.

DAYNA JOHNSON
Certified Dentrix Trainer

Figure 2 The Modify Document Attachments dialog box.

know you can track gratuities in your Dentrix software using
the Referred By Doctor/Other Report?
When you enter the referral source in the patient’s Family
File, you also have the opportunity to add the gratuity. In
the Family File, double-click the Referred By block, and then
next to Referred By click Analysis. In the Referral Analysis
dialog box (Figure 3) you will see a list of all the gratuities this
referring source has received over his or her history of working
with you. To add a new gratuity, click New Gratuity, specify a
Value and Type, and then click OK.
To run a Referred By Doctor/Other Report, in the Office
Manager, from the Reports menu, point to Management, and
then click Referred By Doctor/Other Report. Any gratuities
paid appear on this report.
Having all the information about your referring doctors,
gratuities, and knowing where to find the referral slip is so
important to your practice.

Figure 3 The Referral Analysis dialog box.
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Business of
Dentistry

How to Have a Rock Star Marketing Strategy
Learn proven marketing tips that help
promote rock stars as well as dental practices.

M

y work life has consisted of two seemingly unrelated
professions: dentistry and music. Through over 15
years of marketing coaching to dentists and teams,
it’s interesting how often I find myself reflecting on
my work as a musician and how much dentists and
practice owners could learn from rock bands
about marketing.

the options and information you want to be included in the
report. For information on using these options, click the
Help icon in the bottom left corner of the dialog box. After
selecting the desired options, click Preview to display the
report in the Print Preview window. To print the report, click
the Print icon on the toolbar.
Other reports that contain helpful referral information
include the Daily Huddle Report for New Patients, the

Want to be a rock star in your community?
Here are a few tips from the starving artists
that have made their way to greatness through
grassroots marketing. What’s even better, most
of this costs little to nothing to incorporate into
your strategy! It takes a lot of sweat equity, but
it pays off in multifold.
Build Your Street Team
Most bands, when starting out, slowly but surely
start to build a fan base and then maximize their
most passionate followers by activating them in
the communities they tour as a street team. Street
teams hit the pavement running, passing out flyers
about shows, stirring up opportunities at venues,
wearing and selling merchandise, sharing show
information on social media and more. They do it
with passion and enthusiasm because they love
the band and they want more people to come and
experience the shows!
Did you know you have a street team in your
patient family just waiting to be activated? Here’s
how
Figure 1 The Practice Advisor Report dialog box.
to start. Run a referral report for the past 12
months.
How many patients have referred patients to your
Referred by Patient Report, and the New Patient
practice this past year? That list is where you begin.
Summary Report.
Dentrix includes several reports that provide useful
statistics and other information to help you analyze patient
referrals. For example, the Practice Advisor Report – New
Patient Analysis shows practice details for new patients for
specific time periods, including the number and percentage
of new patients that resulted from referrals. This report also
compares your referral statistics against industry-standard
benchmarks from top dental consultants. You should run
the Practice Advisor Report – New Patient Analysis on a
monthly basis to see how your patient referrals compare to
these industry-standard benchmarks.
To run the Practice Advisor Report – New Patient Analysis,
in the Office Manager, from the Analysis menu, click
Practice Advisor, and then click Practice Advisor Report. In
the Practice Advisor Report dialog box (Figure 1), specify
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Start tracking where your new patients are coming from. And
if you haven’t been asking patients for referrals, start now!
Now, back to the street team. You have your list of top
referrers. Create an internal marketing campaign just to them:
•
•
•
•
•

An email asking them to post reviews for you on
Google or Yelp.
An email or letter with business cards (both is better)
asking for referrals.
Ask them to “check in” on your facebook page at their
next appointment.
Send them a hand written note telling them how much
you love having them as a patient and ask for referrals.
Give them 2 business cards every time they are in the
practice and ask them for referrals!

•

Find every opportunity you can to pleasantly surprise
these people, to show your gratitude to them and to
make your relationship stronger – both when they are in
the practice for an appointment and when they are away.

Those are just a few of the limitless options on how to keep
those top referrers, engaged, excited, and spreading the good
word about you and your practice! Run that referral report on a
regular basis and add folks to the street team list, and keep this
as an ongoing campaign. It never stops. And a new list gets
added every time you run the report. These are your raving
fans. This is your street team.

Once again, you can use the referral tools available in Dentrix
to help manage your network. You may also want to use the
eDex contact manager available in Dentrix G6 and later (Figure
2). To open eDex, from the File menu in most Dentrix modules
click eDex. You can add contacts to eDex and organize them
by category. By default, eDex adds all new contacts to the My
Contacts category, but you can add categories as necessary
to organize your contacts according to the criteria you define.
You can also set filters so you can search by the categories
that you have defined.
You Only Have One Shot to Make the Best Impression
Starving artists rarely get a second chance at
a venue if their first performance was a bust.
If the music is terrible, if the performance
is unbearable, if the musicians are jerks—no
promoter will do much more for such a group,
and rarely will a new listener make the plan to
come back for a repeat experience. You’ve got
to knock it out of the park every time at every
tour stop! That’s how you grow a following.
Are you knocking it out of the park every
time with your patient experiences? The way
you answer the telephone, the cleanliness
and comfort of your facility, the way you
communicate with your patients and show
them that you care all makes the difference
between a one-time visitor to a lifetime
patient. Every team member needs to bring his
or her best to every patient, every time.
And most importantly, just like in music,
practice makes perfect! If you have steps in the
experience that are less than effective, invest
the time and energy to practice together, to be
better, to make the experience your patients,
referring businesses, and community have with
you unforgettable. To be the best, you have to
keep striving and reaching for the best. In time,
you will find yourself the headliner and you will
be the rock star you always envisioned.

Figure 2 The eDex window.

Teams Grow Faster and Better Together
Many bands, especially those showcasing original music or
touring untapped territory, will share a night at a venue with
another, more established band. This is even the case for the
large touring acts—hence the opening acts! What better way to
spread your music to more people more quickly! Who are your
referring doctors? Depending on your focus as a practitioner, you
either have a list of general dentists or of specialists that you refer
out to, and hopefully they are doing the same to you. Do you
have a regular plan in place and scheduled on how you are going
to stay in touch, reach out to these practices, show appreciation,
and so on to help build that relationship and make it stronger?
Let’s take it another step further: what businesses, healthcare
providers, and so forth outside of the dental realm would
be a good fit for you to network and collaborate with?
Dermatologists, plastic surgeons, salons, make-up artists,
just to name a few, would all seem a very natural fit for cross
promotion and support in building up each other’s small
businesses. Think through your community and think about your
practice vision and brand. Who might compliment that with
their services, and who might be taking care of the same target
audience as you? It might be worth making time to connect.

LEARN MORE
To learn more about the Practice Advisor Report and eDex,
refer to ther “Practice Advisor Report” and “eDex overview”
topics in the Dentrix Help.

Carrie Webber is Chief Communications Officer and co-owner
of Jameson, a dental management, marketing, and hygiene
coaching firm that helps dentists and teams become more productive, more profitable, and ultimately more fulfilled in their
practicing lives. Carrie creates customer service and business
development opportunities as well as internal and external
marketing initiatives and social media strategies to effectively
communicate the Jameson message to dental professionals.
For more information, visit www.jamesonmanagement.com or
call 877.369.5558.

CARRIE WEBBER
Chief Communications Officer and Owner,
Jameson Management
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TechNotes

The Importance of a Layered Defense
In Your Dental Practice
•

Layer 2: Encryption Services
To further protect against data theft, you need to
encrypt your practice data so that if your server is
ever lost or stolen, thieves can’t access your sensitive
information even if the drive is moved to another machine. Encrypting the hard drive of your server with the
latest Advanced Encryption Standard (AES) (as of this
writing, AES 256-bit encryption) helps provide another
layer to protect your data at rest from anyone who
does not have your unique key.

•

Layer 3: Redundant Backup Services
Are you prepared for disaster or data loss due to theft,
fire, or water damage? To help protect yourself with an
additional layer, you should keep redundant copies of
your valuable data in two protected locations. A redundant, remotely managed backup and recovery solution should keep your data encrypted with AES-256
encryption, both on the local backup device and on the
cloud server. This helps to minimize human error. And
should disaster strike your practice, recovery of your
data is quicker and more certain.

•

Layer 4: HIPAA
Policy documents that are old may be missing recent
changes to your office or security measures that can
help protect against more current threats like ransomware. Consider an affordable cloud-based tool like
LayerCompliance™ by CAEK that helps guide dental
practices through the requirements of HIPAA. When
used as part of your comprehensive data security program, LayerCompliance™ can help you in your efforts
to achieve HIPAA compliance.

Discover four layers of protection that can
help better protect your practice.

T

he chief asset you have as a dentist isn’t your office or
even equipment — it’s your patient data. Imagine how
devastating it would be if you lost all your data:
patient records, financial and accounting information,
payroll, inventory and more. Unfortunately, it’s possible to
lose it all in an instant.
Think about all the ways your practice data could be at
risk: equipment failure, fire and water, theft and more. One
especially deadly hazard, a data breach from just one wrong
mouse click, could be devastating to your patients’ security
as well as your financial stability. Along with losing income
from patient attrition due to a damaged reputation, you
could also face additional financial damage from large fines.
The key to protecting yourself from the nightmare of
data loss is a layered defense. While no single defense
can protect your patient data completely from computer
attacks, the more layers of security you have, the higher the
chance of catching an advanced threat that other layers
may have missed. The following four layers, when used as
part of your comprehensive data security program, can help
to better protect your practice.
•

Layer 1: Network Security
You probably already have antivirus or anti-spam
software. That’s a great first line of defense — when it’s
kept current. However, you need a firewall for additional network security to provide another layer of defense
to help protect valuable patient health information
(PHI), confidential information and transaction data
from hackers. For a more comprehensive solution, start
with your antivirus software, and then add a robust
firewall appliance like the WatchGuard all-in-one network security solution.
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With a multilayered defense, you can help guard your
practice against different types of data loss. TechCentral
can help you safeguard your practice data by performing
an assessment specific to the dental industry. Request your
network assessment and take the first step toward a better
defense for your most precious asset. Call 844.588.6578 or
visit www.HSTechCentral.com/DentrixMag.

Some of the product(s) and/or service(s) described herein are
provided by a third party. Henry Schein, Inc. and its affiliates (“HSI”)
make no independent assessment of the content and descriptions
provided by such third party, and this content does not constitute
an endorsement by HSI. HSI is not responsible for, and expressly
disclaims all liability for damages of any kind arising out of such
third-party products or services.

HOWARD GRAINGER
Product Manager,
Henry Schein TechCentral

WE’VE
GOT YOUR
BACKUP
Data theft can happen at any time.
TechCentral Hybrid Backup creates
redundant backups so that your critical
data is potentially recoverable from
two AES 256-bit encrypted locations.
Don’t worry because we’ve got your
backup in the event of theft,
ransomware and even alien abduction.

TechCentral—Hybrid Backup

To learn more about the TechCentral Hybrid Backup solution,
visit www.HSTechCentral.com/Dentrix/backup
or call 844.588.6578

SOLUTION SPOTLIGHT
Practice In and
YourDentrix:
Pocket and Dentrix:
ImageRamp
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Easily
Scan to
Dentrix Private
Document
Center
DR. MICHAEL DOLBY DDS, FAGD
Director of Practice Management, Practice In Your Pocket

Discover Practice In Your Pocket—an easyto-use app that syncs with Dentrix to
provide practice management information
on your desktop, smart phone, or tablet.

W

hen I ask dental students what they envision
after graduation, the majority of them express
a common goal of someday having their own
practice. What these soon-to-be dentists don’t realize is
that having a practice of your own is actually owning and
operating a small business. Unfortunately, many dentists
today enter private practice armed with little to no
business training and are at a loss as to how to make their
business profitable.
The dental market is extremely different today than it was
when I started practicing 22 years ago. Back then, I never
heard of a practice going out of business. In fact, even the
poorly run practices made enough profit to meet lifestyle
goals. Dentists today face many aggressive challenges, with
dental school debt reaching all-time highs, declining dental
insurance reimbursement rates, increased operating costs,
and increased competition coming from corporate dentistry.
This leaves many dentists searching for answers as to how
they remain profitable in their small business.

Figure 1 Practice in Your Pocket (PIYP): the complete practice
management resource app.
app integrates seamlessly with Dentrix and QuickBooks,
bringing accurate and easy-to-understand reporting,
impactful practice management tools, and team member
visibility and accountability to your desktop, smart phone, or
tablet (Figure 2).
Dentrix was selected as the operating platform to launch
the PIYP Dashboard, as we believe this is the premier dental

To address this changing landscape, we designed and
developed Practice in Your Pocket (PIYP), the complete
practice management resource app, created by dentists
for dentists, that is changing the way dental professionals
manage and operate their dental business (Figure 1). Relying
on years of owning and operating successful practices and
years of interfacing with various practices through running
a dental consulting practice, the team at PIYP has created
an easy-to-use resource to help every dentist operate
the business aspect of their practice with more precision,
increased visibility, and accountability, allowing practitioners
to operate within the most optimal operating environment
so they can begin to reap the rewards that this great
profession has to offer.
Practice Performance at a Glance
PIYP is a must for any doctor ready to take control of the
success of their practice. This innovative and comprehensive
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Figure 2 Practice in Your Pocket provides reporting and practice
management tools to your desktop, smart phone, or tablet.

practice management
system on the market. Our
goal was to enhance the
user experience that Dentrix
provides by making it easier
to access and by presenting
the critical practice data to
team members and decision
makers so they can better
understand the financial
health of their practice.
When PIYP is installed on
an office computer that is
connected to Dentrix, it will
automatically re-populate
your Dentrix data, production,
collections, and new patients
to a personalized practice
dashboard that everyone on
your team can understand
Figure 3 Practice in Your
Pocket provides a personalized
(Figure 3). Because of PIYP’s
practice dashboard.
integration with Dentrix, your
office staff can eliminate
the task of manually running multiple reports that can be hard
to understand and require additional steps to generate. Your
dashboard will automatically display the most important areas
of your practice, updating the key practice performing indicators
every five minutes throughout the day, so you will have
everything you need to manage your practice all in one place.

experiencing; it’s another thing to know what to do to correct
underperformance. Practice In Your Pocket stands out from
other dashboards by providing useful practice enhancement
resources that are designed to provide you the knowledge to
maximize every opportunity in your practice:
•

TLC Calls™ - This one-of-a-kind resource provides you with
the quickest way to accelerate your practice growth by
generating new patient referrals from your phone on the
drive home (Figure 4).

•

Practice Management Video Tutorials - Your entire team
can learn proven systems and tools for every area of your
practice that can be implemented instantly.

•

Fee Schedule Analysis - Know exactly how your practice
fees stack up against comparable practices in your region,
and see how a slight fee increase could dramatically benefit your top line performance.

•

Procedure Code Analysis - See your top five revenue producing procedures, so you know exactly where to invest in
new technologies for your practice.

•

Team Member Profiles - Store all vital team member information, including performance reviews, job descriptions,
CPR status, and CE courses, all in one convenient place.

•

Overhead Management - Achieving your practice production and collections goals is awesome, but if your expenses
are not managed closely, this will definitely put a strain on
your net profit and will result in increases stress within your
office. PIYP syncs automatically with QuickBooks, providing a clear picture of your financial health and your bottom
line results. No more complicated spreadsheets to read,
just easy-to-understand graphs where you can compare
your practice to industry averages.

Take Control of Your Practice
Dentists sacrifice much along the path to owning and operating
their own practice. With PIYP, our goal was to create a simpleto-use, simple-to-understand tool for practitioners, giving them
more time to focus on their patients and reap the rewards this
great profession has to offer. You can rest easy knowing that the
PIYP app provides important tools to build your practice and
manage your goals.

Figure 4 TLC Calls™ helps you generate new patient referrals.

You will have the knowledge and understanding at your
fingertips with respect to how your practice is performing on a
yearly, monthly, daily, and even hourly basis. With the power of
PIYP, you will quickly understand how to maximize and manage
production, collections, new patients, and overhead. More
importantly, you can quickly address any underperforming areas.

We created this affordable resource so that every dentist could
benefit from this technology. Go to www.PIYP.com to sign up—
your first 30 days is on us. Then go to the Apple or Google Play
Store to download the PIYP mobile app, so you can take the
power of PIYP with you everywhere. You pay nothing up front, no
download fee, no installation fee, and you can cancel anytime, no
questions asked. After your 30-day trial period, it’s just $299 per
month. PIYP is the Affordable Practice Management Solution!
The product(s) and/or service(s) described herein are provided by a third party and
the content and descriptions were created by such third party. Henry Schein, Inc. or
its affiliates (“HSI”) make no independent assessment of the content and descriptions
provided by such third party. HSI is not responsible for, and expressly disclaims all
liability for damages of any kind arising out of such third party products or services.

Practice Enhancement Resources
It’s one thing to recognize challenges that your practice is
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SOLUTION GUIDE
You already depend on Dentrix to make your practice more profitable and productive. Now, you can turn
Dentrix into an even more powerful solution by adding trusted, fully integrated third-party applications
and capabilities to your digital dental office. The Dentrix Connected logo means the product has been
carefully developed, tested and certified to work with your Dentrix platform. To see the full list of Dentrix
Connected applications visit www.Dentrix.com/Connected today.

3M
Apteryx

3Shape
Broadview

Apteryx
BiteBank Media

www.apteryx.com
www.3m.com

www.broadviewnet.com
www.3shape.com

www.bitebankmedia.com
www.apteryx.com

True
Definition
Dental
PracticeScanner
Solution

The
3M™exceeds
True Definition
Scanner—of its
Apteryx
the expectations
available inby
mobile
or cart
editions—
customers
creating
timely,
innovative
offers
unparalleled
accuracy,
ease of
and
cost
effective software
solutions
use, improve
and affordability
for making
fast,
that
the profitability
of the
precise businesses.
digital dental impressions.
clients’

Network-based
Take
advantage of theBusiness
award-winning
Communication
TRIOS
intraoral scanner to enhance patient
experience,
reduce chair-time
and unlock
Make
your practice
more profitable
with
the widest range
of treatment
opportunities.
OfficeSuite
Dental,
the state-of-the-art
Backed
by continuous
software
updates,
phone system
that fully
integrates
with
upgradable
Dentrix
G5.hardware and add-on treatment
modules, TRIOS ensures your practice stays
ahead and your business grows stronger.

Apteryx
exceeds
the expectations
of its
Streamline
your practice
with custom
customers
by
creating
timely,
innovative
dental websites, appointment
and
cost effective
software solutions
notification
and scheduling,
real-time
that
improve
the profitability
of the and
booking,
patient
education videos
clients’
businesses.
reputation management.

Brightsquid

Broadview

DocuFi
DDX

www.brightsquid.com

www.broadviewnet.com

www.docufi.com
www.ddxdental.com

Secure-Mail

Network-based Business
Communication

Document
Digital
Dental
Management
Exchange Solutions

SecureMail is the patient-centric platform for
secure healthcare collaboration. Thousands
of physicians, specialists, allied health
professionals, and patients are improving
quality of life and overall care by sharing
Protected Healthcare Information securely
and efficiently with Brightsquid Secure-Mail.
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TRIOS Scanner

Make your practice more profitable with
OfficeSuite Dental, the state-of-the-art
phone system that fully integrates with
Dentrix.

Dental
Solution
Dental Practice
Practice Solutions

™
We provide
generation
lab case
DocuFi
is next
a certified
Dentrix
partner
management.
Save
and boost
providing tools
to time
capture
and process
efficiency, store
data more
securely,
documents
intopatient
electronic
digital
form.
™
and improve communications
with Fujitsu
your lab.
ImageRamp
for Dentrix, using
Call
877.244.9345
schedule
a demo or
scanners,
offers to
the
most productive
speak to a live
sales representative.
document
scanning
solution for Dentrix.

Demandforce

DEXIS Symphony
Dental

DocuFi
eDossea

www.demandforce.com

www.dexis.com
www.dentalsymphony.com

www.docufi.com
www.edossea.com

Patient Communication Solution

Digital Practice
Dental
Diagnostic
Solution
Imaging

Document
Intra-Office
Management
Communication
Solutions

Demandforce works seamlessly with
Dentrix to
G5automate
software to
online
automate
and offline
online and offlinewith
communications
communications
existing patients
with
existing
to
improve
patients
in-office
to improve
efficiencies.
in-office
efficiencies.

Dental delivers
DEXIS
Symphony’s
innovative,
web-based
high-quality
digital imaging
clinical
softwaresolutions
revolutionizes
to thepatient
dental
community.
management.
With
Working
its state-of-the
alongsideart
Dentrix,
sensor and
Dental
easy-to-use
Symphony
imaging
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software, Dexis
tools provides
to practice
numerous
easier,
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safer
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you, efficiently.
your practice, and your
patients.

DocuFi
We are™ solely
is a certified
focused
Dentrix
on thepartner
dental
providing
profession
tools
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capture
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dental
process
documents
profession into
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electronic
secure, digital
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transfer
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one
productive
office to
document
another. This
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DentalWriter

DEXIS

eDossea

www.dentalwriter.com

www.dexis.com

www.edossea.com

Medical Billing Software

Digital Diagnostic Imaging

Intra-Office Communication

For over 25 years, Nierman Practice
Management has led medical billing in
dentistry by continuously developing
innovative products and providing
exceptional training for dentists looking
to grow their practice.

DEXIS delivers innovative, high-quality
digital imaging solutions to the dental
community. With its state-of-the art
sensor and easy-to-use imaging
software, DEXIS provides numerous
benefits to you, your practice, and your
patients.

We are solely focused on the dental
profession and within the dental
profession on the secure, easy and
inexpensive transfer of your client’s
medical records from one office to
another. This is all we do.

Jakari
imagn Care

Jakari Care

Panda Perio
Lighthouse

www.jakaricare.com
www.imagnsolutions.com

www.jakaricare.com

www.pandaperio.com
www.lh360.com

imagn sleep software

Patient Health Information

Periodontal
Patient
Communication
Practice Solution
Solution

We’ve spent years researching the best
method of implementing sleep in dental
practices. Now you can take advantage
of our complete sleep solution to enrich
the lives of your patients and add new
revenue streams to your practice.

Less work. Better care. Let our HIPAAcompliant solution automatically collect,
analyze and transfer patient medical
history, treatment goals and other
important information into Dentrix.

The
Lighthouse
complete
360
clinical
is a comprehensive
digital record
automated
for Periodontal
patient
practices.
communications
Charting,
comparison
system designed
reporting,
exclusively
treatment
for dentists.
It
planning,
uses email,
automated
two-waychart
text messaging,
notes, and
automated
much more.phone
Save hours
calls, of
postcards
admin time
and
and
letters
unify
to reach
your front
yourand
patients.
back office.
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LocalMed

Patient Activator

Personable

www.localmed.com

www.patientactivator.com

solutions.personable.com

LocalMed

Patient Communication Solution

ScanWriter

LocalMed is a live online scheduling
platform that fully integrates with
Dentrix to provide new and existing
patients online and mobile scheduling
access 24/7.

Patient Activator, part of Los Angelesbased 1-800-DENTIST®, is the leading
social media optimization and patient
communications service dedicated to
the dental profession.

Planmeca

Podium

Practice Mojo

www.planmeca.com

www.podium.com

www.practicemojo.com

Want to know how profitable your practice
can be? Use ScanWriter® Dentrix Edition to
seamlessly integrate your Dentrix® data into
QuickBooks (and other accounting software)
and to improve your practice. You can
automate your accounting process easily now
for real time monitoring of financial health
and key performance indicators.

Planscan

Podium

Patient Communication Solution

Planmeca Romexis® is an advanced,
easy-to-use software suite providing
a rich set of tools to meet the imaging
requirements set by any dental facility –
from a small clinic to a large hospital. It
supports the most versatile range of 2D
and 3D imaging modalities.

Stop the guesswork and know what your
patients are saying. With Podium, you
can impact what’s said, where things are
said, and how things are said. Podium
helps over 3000+ organizations take
full control of their online reputation.
Podium can help you, too.

PracticeMojo creates proven campaigns
that help dental practices recruit, retain
and reactivate patients automatically,
using email, text messages, automated
phone calls and mailed postcards.

Practice Safeguard

Protected Trust

RecordLinc

www.practicesafeguard.com

www.protectedtrust.com

www.recordlinc.com

Web-Based Fraud Monitoring
A web-based financial monitoring tool for
Dentrix users that deters fraud and costly
errors by alerting any device you carry to
unusual transactions in real time.
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Protected Trust
Protected Trust offers simple and
secure email encryption and identity
verification that protects your patient
health information (PHI) by ensuring
privacy and HIPAA compliance.

Patient Communication Solution
RecordLinc is the largest professional
network of dental professionals in
the world. Securely and easily send
electronic referrals, patient transfers, and
track treatment plans between dental
practices in a HIPAA-compliant portal.

Reputation

Sesame

Simplifeye

www.reputation.com

www.sesamecommunications.com

www.simplifeye.co

Patient Communication Solution

Patient Communication Solution

Simplifeye

Reputation.com’s platform enables
dentists to see all their online reviews
in one space and use the platform’s
analytical tools to understand the
broad themes that emerge from
patient feedback.

Sesame Communications helps dental
and orthodontic practices harness the
power of the Internet to accelerate new
patient acquisition, build patient loyalty
and transform the patient experience.

The #1 mobile experience for dental
providers, Simplifeye connects you, your
patients, and your business in amazing
ways via state-of-the-art consumer tech.
Say goodbye to inefficiency and hello to
a whole new way of running your practice.

Solutionreach
www.solutionreach.com

TeleVox
www.televox.com

Transparent Aluminum
www.transparentaluminumllc.com

Patient Communication Solution

Patient Communication Solution

Dental Practice Solution

Smile Reminder provides patient
engagement and communication
solutions for healthcare practices.
Utilizing the latest text, email, voice,
video, web, and social media tools to
communicate with customers.

TeleVox Software is a high-tech
engagement communications company,
providing automated voice, email, text
and web solutions that activate positive
patient behaviors through the delivery
of a human touch.

Transparent Aluminum is a company
focused on creating custom workable
solutions for practices to get the most
out of their Dentrix database.

U.S. Health Record

Updox

Yapi

www.teamlinks.com

www.updox.com

Intra-Office Communication
Teamlinks EHR was created to foster
interdisciplinary collaboration on
patient health information with the goal
of connecting the health care team and
the patient.

Updox Central for Dentrix
Updox is the industry-leading healthcare
connectivity solution, offering dentists and
practices a cohesive suite of services so
practices can focus more on patient care and
less on managing multiple platforms. With
Updox, practices can lower costs, increase
revenue, improve workflow, maximize staff
time and increase efficiencies.

www.yapicentral.com

YAPI
Dental Practice Solution
Started as the first fully integrated
intra-office communication software,
YAPI has grown into a comprehensive
suite of innovative automation solutions
designed around unique needs of
dental practices.

Disclaimer: The product(s) and/or service(s) described herein are provided by a third party and the content and descriptions were created by such third party. Henry
Schein, Inc. or its affiliates (“HSI”) make no independent assessment of the content and descriptions provided by such third party. HSI is not responsible for, and
expressly disclaims all liability for damages of any kind arising out of such third party products or services.
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CAN’T GET
AHEAD OF YOUR
SCHEDULE?
TAP. VIEW. GO.
Introducing Simplifeye. Smart, wearable technology that
connects to Dentrix to help your entire team streamline
patient workflow—from the waiting room to the dental
chair and beyond. See patient details such as procedure,
last visit and medical alerts, all at a glance. It’s the
smarter way to stay on schedule.
Call a Dentrix representative today at 844.633.8002
for more information.

Watch your patient care get smarter at
www.Dentrix.com/Simplifeye/DTXmag
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Henry Schein Practice Solutions
1220 South 630 East, Suite 100
American Fork, Utah 84003

Dentrix does
All THAT?

50 Things You Didn’t Know
Dentrix Could Do
Register for this NEW Insight Seminar TODAY! Only $79! Seating is limited.
To register, visit www.Dentrix.com/InsightSeminar or call 866.367.2711

